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Analysis

Problem

Our goal is to create a mockup of the interface for HippoSoft’s web-based multimedia database on cultural consumer profiles for marketing purposes. We will create a paper mockup to conduct usability testing before creating a final mockup in PowerPoint.

The dimensions of the consumers are stored in cultural 14 categories and the day in the life of specific people. The database never gives information on marketing strategies. 

Stakeholders

Our client is Juicy Fruity, maker of a variety of fruit-flavored drinks.

The target consumers are people from Zimbabwe, though in the future the database will be scaled to other countries.

Researchers in the African Studies program at a university in Pennsylvania will provide much of the database content. Juicy Fruity staff will also enter data. 

The users of the database are marketing managers creating advertising campaigns for fruit drinks for African markets. They have the following characteristics:

· They are designing messages for a variety of media. 

· They want to know about their consumers, but they may know little or nothing about the culture of people in countries (such as Zimbabwe) where they will be marketing.

· They are impatient and their time is restricted by job pressures and deadlines. 

· They are creative yet passive and are looking for quick stimulation and inspiration.

· They prefer small chunks of information, and a mix of media instead of mere text.

· Some are frequent users of the database, and some are infrequent users.

Goals

The database must be reliable, user-centered and secure, and it must follow Juicy Fruity information systems standards. It must be consistent and Web-codeable. It must be easy to learn since there are many infrequent users. It must also take advantage of the computer medium in creative, innovative ways.

The user should be able to use the database to find, input, display and navigate within documents.

Design

Focus of Mockup

We have focused our design on viewing and navigating within Day in the Life documents. We do not address finding and inputting documents or the 14 cultural categories, but in Appendix A we suggest the design of the rest of the interface to show how our parts would fit in.

However, we recommend that a complete, consistent interface design is created and usability tested before programmers write the code for the interface (e.g. HTML, Java and JavaScript).

Displaying Documents

A document is an ordered list of media objects (we only use text and pictures, but it could also include sound, video, and hyperlinks). A “Day in the Life” document is an ordered list of pictures. Each picture has a title, start and end times, and paragraphs of description (4 text objects), and possibly other data objects.

A View menu allows switching among these views of documents: 

Text Profile: Text, pictures and hyperlinks with small icons representing sounds and videos. It scrolls vertically, but all other views scroll horizontally.

Slide Show: Only a large picture. If the picture has associated text, it is automatically read aloud by a speech synthesis program.

2x2: Four pictures in a 2x2 grid. 3x3: Nine pictures in a 3x3 grid.

Collage: A random selection and arrangement of overlapping photos showing activities of other people similar to those of the original person.

People: A button toggles between viewing the day in the life of one person (one consumer profile) and several people. 2x2, 3x3 and collage views can show many people. Text Profile, Slide Show, 2x2 and 3x3 can show one person.

Get More Pictures: A button that chooses new but similar photos from the pool of possibilities.

Navigation Within Documents

Navigation Area (bottom of screen): A slider allows navigating to different times of day or night which are represented by a sun, moon, blue-to-black background color blend, and tick marks with times. Next and Previous double arrows on the right allow navigating between screens within a document one at a time. Play and stop buttons control an automatic slide show. Sound controls (on/off and volume) are also in the lower right corner. A full screen button toggles between normal and full-screen mode. It has an icon with four arrows that show a small box growing into a large box.

Pictures: Mouseover on a picture highlights it with a colored border. Clicking on a picture selects it (and brings it to the front in collage view). Double-clicking on a picture enlarges it by switching views into the slide show view. Right-clicking on a picture brings up an object-oriented (context) menu that allows the user to do various things with the picture (save, select, enlarge, etc.).

Usability Test

Test Subjects

We conducted the test with our paper mockup on the afternoon of Saturday, March 6 with three subjects: two in the atrium of the Education building, and the third in a fraternity. They all had at least some knowledge of marketing. Three group members tested each subject. (The fourth group member had an excused personal absence.)

Test Structure

The test subject was required to read the instructions, answer background questions, perform tasks using the interface, and answer some general questions. For more information, see Appendix C.

Usability Questions and Findings

The three subjects we tested all had different experience with computers and with interfaces similar to ours. The feedback we received from the three subjects, however, was surprisingly similar. This feedback helped us to pinpoint certain aspects of the interface that required reconsideration. These findings, along with justification for their reconsideration, are outlined in the following usability test results.

Viewing Documents

Question 1: What views of the data would be most and least useful to the users?

Results: The users seemed most comfortable with the text and picture view. This view is the initial view at the start of the usability test. To begin the test, the first question is “What are the functions of the menus, buttons and controls you see?” All three of the subjects were able to accurately describe the functionality of the left menu. Further, all three subjects were able to navigate through the text and picture interface when prompted with the second request, “Find out what the person is doing at 4 p.m.” 

To further illustrate the three subjects’ comfort with the text and picture view, when the subjects were asked which views they liked or disliked, it was concluded that they all liked the text view the best. When asked why they chose this view over the others, they said they liked the organization of the information to include both text and pictures. They also liked the fact that all of the information was laid out in front of them. They commented on the disorganization of the collage mode as compared to the text mode.

Question 2: Which view is the most important and should be the default view?

Results: Based on the results attained by the usability test to answer our first question, it can therefore be concluded that the text view should remain the default view.

Question 3: Does the user find it easy to switch between views?

Results: There were a series of questions related to the ease of navigation between views. The subject begins at the text and picture view. When asked how they would enlarge a picture, they subjects all knew to click on the picture. At that time, they may not have been aware that enlarging the picture also threw them into slide show view, but when they were told this was the case, they reacted positively. They were also aware that slide show view could be reached by selecting slide show from the toolbar. 

Next, the subjects were asked to, “display randomly arranged pictures.” On the whole, they had no trouble selecting the View—Collage function from the menu in the main toolbar. 

Our final test question for navigation between views received the most helpful results. The subjects were prompted to “return the screen to how it was when you started” from the collage mode. At the time of the usability test, a button labeled “Text Profile” was present on the main toolbar. None of the users said they would push this button. One subject said he would use the back button, but there was not one provided. The second subject drew a blank stare, and the third hesitantly chose “Text Profile” but expressed his concerns for the use of the word “profile.” This finding caused our group to re-think the name for the initial text and picture page, and to eliminate the “Text Profile” button. 

Question 4: Do users understand the concept of viewing one versus many people? 

Results: No. When the user begins with the text and picture mode, it was not clear that he/she was seeing a specific person’s day. This may have been caused by a lack of similarity between the pictures, due to limited availability. Also, the text and picture view gave no indication that it was expressing one person’s day. For example the name of the person did not appear anywhere on the screen. 

Furthermore, the user was unable to grasp the concept that the text and picture view was meant to see into one person’s “day in the life” and the collage view was meant to illustrate many, related people. In other words, the collage view is a navigational tool for finding peers with related interests or lifestyles to the person whose life you were seeing in text and picture view. These findings caused the group to re-evaluate the way in which the two modes, singular and multiple people were expressed in the interface. Also, the group had to ensure that each view made it known to the user which view they were actually in. 

Navigating Within Documents

Question 1: Which navigational controls worked well, and which gave the user difficulty?

Results: The slide show toolbar seemed to be the topic of some controversy. Below is the slide show toolbar as it was during the usability test.
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As seen above, the Full Screen toggle button is incorporated within the slide show toolbar. This caused some confusion with the users, because it is not only a slide show function. Furthermore, the subjects would like to have seen the Full Screen button in the upper right hand corner of the interface, similar to the design of Windows. One user commented that because the word sound was present on the toolbar, he thought that all of the buttons would be related to sound. Another user commented that the Full Screen button looked more like an X than arrows. 

Question 2: Which navigational controls does the user prefer to use?

Results: The subjects like the bottom toolbar in the collage and slide show views. The toolbar expresses the “day in the life” chronologically using a sun and a moon. The user is able to drag a marker through the day. In the text and picture view, the user liked the scroll down capability as well as the short cuts to various points in the day by using the relative links in the left toolbar. 

General

Question 1: What else did the users like or dislike?

Results: The subjects liked the interface as a whole, rating it a 4 and 2 ½ or 3 on a five-point scale. 

In addition to the items already discussed, the users had some other comments on their likes or dislikes of the interface. First, the users unanimously preferred that the slide show did not run by itself when it is first initiated. They all preferred to navigate through the slide show manually. In addition, the users also stated that they would prefer that the sound not be on as default during the slide show. 

On a different note, user B said the reorganizing options of the collage in to 2x2 or 3x3 was unnecessary, while user C thought that the 2x2, 3x3 were the dimensions of the image. 

Question 2: What did the users understand easily or with difficulty?

Results: The users easily understood the “day in the life” concept. They were able to maneuver through the day using a variety of control functions. What they did not understand was the concept of the Select feature in the right mouse click menu of collage mode. The select feature was meant to hold a picture on the screen, while other, related pictures were loaded from the database. This was confusing because, the user was not really aware that other such pictures existed, or of the reason one would want to hold on to a certain picture. Also, as expressed earlier, the users had trouble distinguishing the fact that the text and picture view was singular and the collage was meant to illustrate many pictures of other lives related to the one outlined in text and picture view.

Question 3: Is the interface intuitive and easy to learn?

Results: When asked to rate the interface as Expert or Novice, subject A gave it an “Intermediate,” and subjects B and C a Novice. All three subjects felt they were able to control the interface “Fairly easily.” However, some aspects of the interface were not easily understood, such as the previously discussed variation from multiple to single person modes.

Question 4: Are there usability differences between experienced and inexperienced users?

Results: Yes. Subject B had less computer experience coupled with less business marketing experience, which let to a less intuitive understanding of interface concepts. Subjects A, and C, on the other hand, used their computing experience and knowledge of general concepts related to the interface to make for a much smoother usability test session.

Redesign

1. The full screen button was changed to look like the one in Microsoft Internet Explorer 4. When the user is in full screen, an information dialog indicates “To close full screen, press Esc.” The user can click OK. A checkbox indicates “Do not show this again” so the user only sees the dialog once.

2. The menu bar was moved to the top of the screen to be consistent with other Windows applications.

3. The View menu was renamed (from Select View). It was reorganized so that Normal indicates text and pictures. Normal view is only for one person, Slide Show is for one or many people, and the other three views, Collage, 4 Pictures (2x2) and 9 Pictures (3x3), are only for many people and therefore appear on a submenu.

4. Although the usability test indicated that our subjects disliked collage view, we believe that it was because we were unable to show them how it would work. We decided to keep this feature because we felt it would still be a useful tool for marketers.

5. Sound volume was removed because it was considered a function of the operating system. (The on button always starts the sound from the beginning.) A line was added to separate sound from slide navigation. (It could be further improved by putting the sound button on the far right.) 

6. In order to make the application more understandable for first time users, we decided to add a help function.  The help function can be accessed from the tool bar by pressing the question mark icon located in the right side corner or by pressing F1.  There should be a short description of how to use the interface, and depending on current selected view, also specific information about the functions relevant to the respective views.  This function would not only facilitate and accelerate the learning process, but also make the interface more consistent with other application.

7. In the usability test some users were confused about the application’s relation with the WWW.  Some considered it be a web page designed for use with a browser.  However, decided that the interface should not be used in a browser, but rather as a stand-alone application.  To reflect this decision in the mockup, the interface is placed in an ordinary application window.  Since the database is designed for use on a corporate intranet and not for the general public, a stand-alone application (written in Java for example) will give more computer power and better user interaction.  In addition, the interface uses multimedia objects, which require high-speed connections that are not currently widely available for the personal user.

8. We also have changed the menus that pop up when the user right-click on an image.  No matter what view the users are, in a menu will pop up on a right-click.  This will ensure consistency and follows the principle that rules are enforced.  The functions on the menu are; Bring to Slide Show (this function is in bold, because it serves the same function as a double-click), Bring to Normal View (not available in normal view), Copy, Save As…, Select.  A double-click on an image, no matter what mode the user is in, will always bring the picture to slide show.

9. Just below the toolbar at the top of the page is a navigation feature that shows the user which consumer profile he is looking at.  In the usability test, we used a teenager profile, and listed the profile’s place in the different regional categories.  Home >> Regions >> Zimbabwe >> Teenager.  All these categories can be click on, to return the user to the selected category.  In the mockup, the category which is user is currently in will be dimmed out to reflect that it cannot be selected.

10. On overall, the mockup takes into account several functions and additions that the usability test indicated.  Especially, the organization of the different views has been greatly improved and should facilitate navigation between the different views.  This improvement will also make the use of the Collage and the other pictures views look more appealing to the users.  

Appendix A: Problem Statement Notes

Content

The cultural dimensions of the consumers will be stored in categories such as gender and family, migration/movement, leisure, changing values/traditions, health, education, making a living, media, social trends, ceremonies, religion/spirituality, money, language, and community.

The data content will come from secondary sources like library research and primary sources like field research and observation.

Stakeholders

The contact is Morgan Pierce, Chief of International Strategy.

We will focus on those wealthy enough to purchase soft drinks reasonably often.

User Characteristics

· They are designing messages for television, radio, billboards, posters, newspapers and magazines. 

Appendix B: Design Specifications

Finding Documents

Home Page

The home page should be a colorful introduction to the database. 

It should have about 5 to 7 images that link to other index pages, such as: 

· Geography (countries, regions, rural/urban areas)

· Demographics (characteristics of people such as age, gender, income level and ethnic group)

· Culture (the 14 cultural categories plus Day in the Life)

· Resources (links to related outside Internet sites)

It should also have the search box and smaller links to Juicy Fruity and HippoSoft home pages.

Navigation Between Documents

The user can drill down to the data by choosing from the above categories in any order. 

For example, to view a Day in the Life of a teenaged Shona male from Harare, the user could start with Geography and choose Zimbabwe and Harare, then click Demographics and choose teenaged Shona male, and finally click Culture and choose Day in the Life. Alternately, they could start with Culture, then go to Demographics and then to Geography.

On every document or index page, the path to the file will be shown. For example, the path could be Zimbabwe > Teenager > Day in the Life or Day in the Life > Teenager > Zimbabwe.

When trying to find a page, instead of following hierarchical links, the user could choose country, demographic characteristics and cultural category from drop-down lists. The user could choose some or all variables in any order, so instead of having a hierarchical list of arrows like in Yahoo, we would have just a list of variables and values.

For example, instead of "Zimbabwe > Teenager > Day in the Life", we would have "country=Zimbabwe & age=Teen & culture=Day in the Life".

Also, this looks like the URL for a web search and could be fed to a CGI program. 

Document Formats (How Data is Stored)

The database will contain facts or objects in graphics, text, video, sound and hyperlink formats. These objects must be grouped into documents, and these documents must be grouped into cultural categories.

A document is an ordered list of media objects (text, sound, picture, video, and hyperlink).

Each document has a title, a list of keywords, and values for one or more Geography, one or more Demographics, and one or more Culture variables.

Each data object has a title, keywords and one of the 14 cultural categories.

Objects can be grouped together within documents, e.g. a picture can have associated text and sound.

Search Function

The search function allows the user to start a search from any page.

The user types in some keywords in a text field and clicks a Search button.

The search results are a list of index pages, a list of documents, and a list of data objects.

An advanced search page would also allow the following:

The user chooses from a drop-down menu whether to search the entire database (the default), or only one of the index categories, which will be listed on the menu.

Each list contains up to 10 items by default, but the user can increase this number (to 25, 50 or 100).

The user can click check boxes to search for index pages, documents and/or data objects, and text, pictures, sounds, videos, and/or hyperlinks.

Inputting Documents

Documents and objects can be created, modified or deleted. Every page should have a place to add, edit or delete information. This should appear as items on the File menu (e.g. Create, Modify, Delete or New, Open, Save).

The user could click File->Save to save the document selected objects or to a local disk. For saving entire pages, the user could use File->Save in the browser menu.

For security, a username and password should be required for modifying the database.

Displaying Documents

The user might not be satisfied with just one view of the data. Although the user would spend most of the time in the normal view, he or she might look at the other views for inspiration. 

Sometimes the user might be looking for detailed textual information, and other times the user might just want to look at pictures, which convey information more quickly.

Navigating Within Documents

The collage view has the advantage of combining related pictures from several different people, so a marketer could chain from one person to another easily. The random arrangement of pictures provides more possibilities than a static page that is always the same.

The multiple representations of different times of day on the scrollbar gives the user a clear indication of where he or she is in the sequence.

Appendix C: Usability Test Instructions

Instructions for Test Subjects

To the subject: Please read this page aloud and feel free to ask questions.

Overview

This usability session will take about 30 minutes. In this session, you will:

1. Read the following scenario and instructions.

2. Answer some questions about your background.

3. Use the interface by performing specific tasks.

4. Answer some general questions about the interface.

Scenario

Imagine that you are a marketing manager for Juicy Fruity, an international soft drink company. You are trying to create ad campaigns for television, radio, billboards, posters, newspapers, magazines, etc. to sell Juicy Fruity products to new foreign markets. You have been assigned to Zimbabwe. You have plenty of normal marketing data, but what you really need is more information about the culture of Zimbabwe, which we will provide in the form of a web-based multimedia database.

Our task is to create the computer interface for this cultural database. So far, we have only created a paper prototype to test our ideas before investing a lot of time on implementing them. We need your help in testing this database.

General Instructions

· We are trying to find out what problems the interface has. Please tell us when you see problems. Keep in mind that we are testing the interface, not you.

· While you are performing the tasks, please think aloud so that we know why you are doing things. 

· Please ask questions so we know what you don’t understand, though we might not answer some questions until the end of the test.

· All information will be held confidential and will only be used for this assignment.

Usability Tasks

For each task, we will ask the user to perform the tasks, observe and record how the user tries to do the tasks (e.g. use the slider or previous/next arrows), and only tell them how to perform the task if they give up. The user will point to controls, and we will switch pages to simulate an interactive program on the computer screen.

The user starts with the screen in text and picture view of the day in the life of a Zimbabwean teenager. [Note to observers: write observations in the spaces provided.]

Appendix D: Usability Test Data

Background Questions

1. What is your first name? Age? Gender? School major?
A. Michael, 25, M, Business
B. Mia, 19, F, Business
C. Jeff, 21, M, Finance

2. How many hours/week do you use computers? How many years have you used them?
A. 20, 15
B. 5, 4
C. 2-4, 3-4

3. How many hours/week do you browse the Web? How many years have you used it?
A. 2, 4
B. 2, 3
C. 2, 3

4. How often do you use Internet search engines? How familiar are you with them? Which ones do you like?
A. always, 5 of 5, InfoSeek and Yahoo
B. always, very little, Alta Vista, HotBot, and Yahoo
C. 1-2 hours/week, GoTo and Yahoo

5. How much knowledge do you have of marketing? Zimbabwe? anthropology?
A. Director of marketing for school corporation in Bloomington, 2 of 5, 2-3 of 5
B. Little, even less, more
C. took one class, 1 of 5, 2 of 5

Summary

· A is experienced in both computers and marketing.

· B is less experienced in both.

· C is between A and B.

Usability Tasks

Task we ask the user to perform

What we expect the user to say/do 
User actions, questions, and comments

A. Michael B. ? C. Jeff

What are the functions of the menus, buttons and controls you see?
A. Correctly described content list, search, external links, slide show. Expected cursor to change to finger to enlarge picture.

B. Correctly described content list, search, external links, slide show.

C. Correctly described content list, search, external links (references).

Find out what the person is doing at 4 p.m.

Scroll down or click 4 p.m. on the left menu bar.
A. Click on 4 p.m. [when prompted for another way] scroll down.

B. Click on 4 p.m. [when prompted for another way] scroll down.

C. Click or scroll [correct]

Enlarge the picture. 

Double-click it or use Slide Show view.
A. Click on it. [when prompted for another way] Double click.

B. Click on it. [when prompted for another way] Double click.

C. Click related pictures button. [when prompted for another way] Double-click or right-click to see what options there are.

Make the picture fill the screen.

Click the Full Screen button.
A. Did not know. [when told to look at bottom] Maybe the button on the far right, but it’s not very clear.

B. Select View. [when told the answer] It looks more like an X than arrows.

C. Select View, 3x3. [when told the answer] He looked at the toolbar, but he thought all the controls were related to sound.

Look at the next picture.

Click the double right arrow or scroll right.
A. Click the double right arrow.

B. Click the forward arrow. [when prompted for another way] Move this [slider].

C. Use the arrows [correct], “fast forward or reverse,” or drag the slider.

Return the picture to enlarged size. 

Click the Full Screen button.
A. Click [the full screen button] again.

B. Click [the full screen button] again.

C. Click the enlarge [full screen] button again.

Flip through all the pictures. 

Drag, scroll or click the scrollbar.
A. Click the right arrow several times. [when prompted for another way] Click the Load More Pictures button.

B. Scroll.

C. Use the buttons or scroll.

Return the screen to how it was when you started. 

Scroll to the original picture and click View->Text and Pictures.
A. Click the back button in the browser a few times. [when prompted for another way] Click select view.

B. 

C. Hesitantly chose Text Profile. Does not like the word profile.

Display randomly arranged pictures. 

Click View->Collage.
A. View. “Did I see collage somewhere?” [but Collage was not an option on the menu presented to him at the time; after a few seconds] maybe related pictures. “Why would I want to see randomly related pictures?”

B. View, Collage

C. View, Collage

Rearrange the pictures. 

Click Load More Pictures button.
A. View? Could use 2x2 or 3x3. [correct but not what we expected]

B. View

C. Load More Pictures. [The question we actually asked this user was “How would you view different pictures?]

What do you expect to happen if you move the mouse over a picture? Try it. 

The picture is highlighted with a colored border.
A. Click the picture to highlight it and double-click to enlarge it.

B. I don’t know.

C. The picture will blow up [enlarge] or you can transform it to how you want it [change views].

What will happen if you click once on a picture? Try it. 

The picture is selected and brought to the front if other pictures overlap it.
A. It is selected. [correct]

B. Some text pops up explaining the picture.

C. Does not know.

What will happen if you right click on a picture? Try it. 

A context menu appears.
A. Menu. [correct]

B. [not asked]

C. other options would pop up [correct]

What will each of the menu items do?

Slide show

Profile

Select
A. Saves the image to the hard drive or floppy. [correct] 
Brings it out of the collage and into the slide show. [correct] 
Name of the photo, with its dimensions in pixels. [incorrect] 
Don’t know.

B. Saves the image. [correct but vague]
Incorporates the picture into the collage. [incorrect]
Tells where the photo was taken, who/what is in the picture. [sort of]
Don’t know what it will select.

C. Saves the picture into a file. [correct]
Slide show is the same as the button. [correct]
Explains the picture. [sort of]
Unsure.

Display 4 or 9 pictures at a time. 

Click View->2x2 or 3x3
A. [not asked]

B. View, 2x2 or 3x3

C. Select View, “nothing there”. See what’s in File menu. [when told the answer] Did not know if 2x2 was the size.

How would you select more than one picture at a time?

Shift-click.
A. Click one, hold down control, click another.

B. Drag, or select again.

C. Did not know.

What would happen if you select a picture and click Load More Pictures?
C. It would load more pictures based on the ones I have selected.



Follow-Up Questions

Note: Some of the user responses have been moved to the questions they answer.

1. Overall, did you like the interface or dislike it?
A. Liked (4 of 5)
B. 3 or 2 ½ of 5
C. Liked it on the whole.

2. What was well organized? What was disorganized?
A. 
B. Didn’t understand the lower right corner.
C. Confused by the lower right; it was not clearly labeled.

3. What was consistent? What was inconsistent?
A. The layout and toolbars are consistent.
B. Don’t know.
C. [Was it consistent?] Yes.

4. Which views do you like? Which do you dislike? Why? Which view would you use most? Is it easy to switch between views?
A. The text view is best. The collage is worst because randomly sorted, maybe not what I want, not organized. 
B. The text view is best because it gives the most information, is concise, and easy to navigate by scrolling. Why are there 4 or 9 photos at a time? It doesn’t seem useful. 
C. Are all these pictures [with text] correlated with those in the slide show?
I’d like to see what’s going on, what they are voting for in this picture and what’s happening. The text was informative, and I would spend most of my time there.

5. Would you prefer the slide show to advance automatically or manually?
A. Manually. There should be an auto-advance button and a pause button to get information from there.
B. I would rather be in control of it. 
C. I would prefer to run it myself.

6. Would you prefer sounds to play automatically or only when clicking the sound icon?
A. There should be a button to start the sound.
B. I would rather not have something read to me.
C. I don’t like sound at all. [When asked if he would turn it off right away] yes.

7. Which icon pictures were clear, and which were unclear?
A. The slider is clear. The “big screen” button with arrows looks like you can move around the picture. He was used to seeing a full screen button in the upper right.
B. If you use it more it will become more clear. [finding: it is not intuitive]
C. They were clear except [the full screen function in] the lower right corner.

8. What terminology used on buttons or menu items was unclear?
A. Text Profile, Select (should say Select more than one)
B. What is a profile? What does Text Profile do?
C. 

9. Which control functions were obvious, and which were confusing?
A. The X [in the content window] would eliminate the content menu [window]. The –is not clear.
B. Text Profile and Select View. You’re unsure what you’ll get.
C. The toolbar was a bit confusing. Is it related to sound?

10. Is there too much information? What information is missing?
A. No. 
B. There should be more text than pictures.
C. No; hard to answer because you didn’t show me any. 

11. Which features (menu items, buttons, etc.) did you find the most useful? Which features would you never use?
A. He would never use the collage.
B. They were all useful, but the least useful were the enlarge [full screen] button and the 2x2 and 3x3 views.
C. [What features were attractive?] He liked the search.

12. Are there too few features for you to access the data? Is the screen too cluttered?
A. 
B. It’s ok.
C. No.

13. Were you able to control the program easily?
A. Fairly.
B. 
C. Fairly easily.

14. Were you able to accomplish all tasks the way you expected? Explain.
A. There should be a button to return to the home page.
B. Going from collage to text takes two different steps. [a misconception]
I would like to be able to go to other references sites. I don’t get all my information from just one site.
C. Yes.

15. Does the program appear to be for a novice or an expert? Why?
A. Intermediate.
B. Novice: a younger person would like the pictures and simple text.
C. Novice.

16. Do you have any other comments or questions about the interface?
A. No.
B. Are all the pictures about the same person?
This reminds me of a CD-ROM on India which was more aesthetically pleasing with music, but it had a different purpose.
C. No.

Appendix E: Lessons Learned

Group Work

· Start early. It took us a week to form our group and another week to schedule our first meeting. We had less than two days for our redesign.

· Keep group size small if possible. When our group had five members, we could not find a time when everyone was available to meet.

· Divide tasks more evenly, and according to the skills of all group members.

· Be ready to compromise, and try to understand the logic behind each other’s ideas rather than accept arguments based on personal preference.

· Do not meet for more than two hours. When the discussion is going in circles, adjourn and send each other ideas and reasons through e-mail.

· Always cc: everyone in the group in every message, no matter how trivial it might seem.

Usability Testing

· Before making usability tasks, clearly define usability questions that the tasks will help answer. That is only possible after agreeing on the functions of the interface.

· Although the users will have some general comments, avoid asking too many general questions. Focus on questions that are specific to the interface being tested. 

· Make sure that no two questions unintentionally ask the same thing.

· The testing format should allow the user to explore if the user does not guess the answer immediately.

· Avoid asking too many leading (biased) questions. Avoid pressuring the users to give answers that the testers expect and that are pleasing to the testers.

· Carefully word all questions to be clear and unambiguous so that two users do not interpret the same question differently.

· Read the questions verbatim, since rewording may give a very different response, and different individual tester personalities greatly affect how they are asked.

· Feel free to ask follow-up questions inspired by user responses, but be careful not to bombard the user with too many fast questions.

Human-Computer Interface Design

· Make more sketches on paper before creating a polished paper mockup.

Appendix F: Other Deliverables

Paper Mockup

PowerPoint Mockup










Slide Show advancement options





Sound Toggle





Full Screen Toggle
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